
114  •  Microsoft Word | Introduction to Word

Microsoft Word 2013 is a word processing application—a program used to type and format 
text, insert and create graphics and tables, and create documents such as letters, reports, and 
newsletters.

You can use Word to type and edit text. You can edit your work using Word’s spelling and 
grammar tools. You can fix errors as you type or scan the entire document for errors. As you 
compose your documents, you can quickly delete, insert, and move text.

You can use Word to apply a variety of fonts, sizes, and colors to the text in your documents. 
You can also add lines, borders, and shading to emphasize document elements. Formatting tasks 
can be performed quickly using the Format Painter or by assigning predefined styles.

You can insert graphics into Word documents or create your own using tools such as Text 
Effects, drawing objects, or SmartArt. Data can be inserted into tables. You can then format and 
position these objects to create the documents you desire.

Word can be used to collaborate with others. For example, you can save documents to the 
Internet and invite others to view them or make changes to them. You can also track the changes 
each collaborator makes to your documents, and then accept or reject those changes.

Word also has tools to perform specific tasks such as printing individualized documents using 
mail merge. You can also create citations and bibliographies using the Source Manager.

Word’s features and tools enable you to create simple documents such as letters, memos, and 
reports and more elegant documents such as newsletters and forms.

Introduction to Word
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116  •  Microsoft Word Chapter 1 | Create Letters and Memos

C h a p t e r

Create Letters and Memos

▶	 Microsoft Office Word is one of the most common productivity 
programs that individuals use on a computer.

▶	 Word is used to create documents such as memos, reports, letters, and 
mailing labels. These documents can include tables and graphics.

▶	 To work efficiently with Word, entering text, formatting text, and 
navigating within a Word document are the first basic skills you need.

▶	 You can change the font and font size and add emphasis to text, but use 
caution not to apply too many different formats to your text. This can be 
distracting to the reader.

▶	 It is never acceptable to have errors in spelling, grammar, or word usage 
in your documents; you can use Word spelling and grammar tools to 
prevent this.

▶	 Business letters and memos are often structured and formatted in a 
formal manner as described in The Gregg Reference Manual by William 
A. Sabin.

Aspen Falls City Hall
In this chapter, you will assist Evelyn Stone, Human Resources 
Director, to create a letter to Dr. George Gato of Aspen Falls 
Community College. The purpose of the letter is to establish an 
internship program between City Hall and the students in the 
Information Systems Department chaired by Dr. Gato.

Microsoft Word is used often to write business letters and memos. 
You can quickly type, edit, and format text. Because business 
communication documents should be free of mistakes, spelling 
and grammar errors are flagged as you type. Most businesses apply 
a standard business letter format to all letters coming from the 
organization.

In this project, you will write a one‐page business letter using the 
block style as defined by The Gregg Reference Manual by William A. 
Sabin. The block style, also called the full‐block style, typically begins 
all lines at the left margin except for letterheads, tables, and block 
quotes. You will add a second page detailing the various internship 
positions available with City Hall.

1

© Julien Eichinger

9780133142686_WRD_C01.indd   116 18/02/13   2:59 PM

USKAAAN
Callout
Two page chapter introduction 



Create Letters and Memos | Microsoft Word Chapter 1  •  117

Outcome
Using the skills in this chapter, you will be able to 
work with Word documents like this:

Time to complete all 10 
skills – 60 to 75 minutes

Introduction

wrd01_InternPositions
Student data file needed for this chapter:

You will save your files as:
Last_First_wrd01_Interns (Word)
Last_First_wrd01_Interns (PDF)

60-75
	min.

Skills
At the end of this chapter you will be able to:
Skill 1	 Type Letter Text
Skill 2	 Apply Styles and Set Grammar and Spelling Options
Skill 3	 Select and Insert Text
Skill 4	 Copy, Cut, and Paste Text
Skill 5	 Check Spelling and Grammar
Skill 6	 Check Writing Style and Insert Synonyms
Skill 7	 Use Format Painter
Skill 8	 Apply Advanced Font Settings
Skill 9	 Create Document Footers
Skill 10	 Save Documents as PDF Files

More Skills

Skill 11	 Prepare Documents for Distribution
Skill 12	 Insert Screen Shots into Documents
Skill 13	 Split and Arrange Windows
Skill 14	 Insert Symbols

Skills 1-10 Training
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118  •  Microsoft Word Chapter 1 | Create Letters and Memos

Eight
paragraphs

Figure 2

Show/Hide
button

Paragraph
formatting mark

Figure 1

Skill 1: Type Letter Text

▶	 When working with Word documents, a 
paragraph can be a single line containing a 
heading or several lines of sentences.

▶	 To see where paragraphs begin and end, it 
is helpful to display formatting marks—
characters that display in your document 
to represent nonprinting characters such as 
paragraphs, spaces, and tabs.

	 1.	 Start Word 2013, and then on the start 
screen, click Blank document.

	 2.	 On the Home tab, in the Paragraph 
group, click the Show/Hide button 
to display the nonprinting formatting 
marks, as shown in Figure 1. If the 
Navigation pane is open, Close  it.

The Show/Hide button is a toggle 
button—a button used to turn a feature 
both on and off. The paragraph mark (¶) 
indicates the end of a paragraph and will 
not print.

Because many elements in the Word 
window adjust to your monitor size and 
personal settings, you may need to change 
your window size, exit Reading Mode, 
or disable Full Screen Mode to match the 
figures in this book.

	 3.	 With the insertion point in the blank 
paragraph, type Aspen Falls Human 
Resources and press Enter . Type 500 S 
Aspen Street and press Enter . Type Aspen 
Falls, CA 93463 and press Enter  two 
times.

	 4.	 Type May 8, 2014 Press Enter  three times, 
and then compare your screen with 
Figure 2.

The letter has eight paragraphs—three for 
the letterhead, one for the date, and four 
blank paragraphs.

Continue to the next page to complete the skill

skill 1.1 
video
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138  •  Microsoft Word Chapter 1 | Create Letters and Memos

More Skills

The following More Skills are located at www.pearsonhighered.com/skills

To begin, open your web browser, navigate to  
www.pearsonhighered.com/skills, locate the name of your 
textbook, and then follow the instructions on the website.

More Skills	 12	I nsert Screen Shots into Documents

When you are working on a document, you may want to include 
a screen shot from your computer—such as a screen from 
another program or a website—as a graphic in the document.

In More Skills 12, you will use a browser to go to a government 
website, and then create a copy of the screen and store it in the 
Clipboard. You will then paste the screen into a document.

In More Skills 13, you will open a multiple‐page document, and 
split the screen. Then, you will open a second document and 
view both documents at the same time.

To begin, open your web browser, navigate to  
www.pearsonhighered.com/skills, locate the name of your 
textbook, and then follow the instructions on the website.

More Skills	 13	S plit and Arrange Windows

You can split the Word screen, which lets you look at different 
parts of the same document at the same time. In a multiple‐page 
document, this is convenient for viewing both the first page and 
the last page at the same time. You can also view two different 
documents side by side and make comparisons between the two.

In More Skills 14, you will open a document and insert 
several symbols from the Special Characters list in the Symbol 
dialog box.

To begin, open your web browser, navigate to  
www.pearsonhighered.com/skills, locate the name of your 
textbook, and then follow the instructions on the website.

More Skills	 14	I nsert Symbols

There are many symbols that are used occasionally, but not 
often enough to put on a standard computer keyboard. Some 
examples of commonly inserted symbols include copyright and 
trademark symbols, mathematical operators, and special dashes 
that are longer than hyphens. These symbols can be found and 
inserted from the Symbols group on the Insert tab.

Please note that there are no additional projects to accompany the More Skills Projects, and they are not covered in 
the End-of-Chapter projects.

Before sharing a document with colleagues, it is good practice 
to remove any hidden data or personal information embedded 
in the document. You can use Document Inspector to help you 
remove any information that you do not want to share.

In More Skills 11, you will open a document that has comments 
and other document properties, inspect the document, and then 
remove all personal information.

To begin, open your web browser, navigate to  
www.pearsonhighered.com/skills, locate the name of your 
textbook, and then follow the instructions on the website.

More Skills	 11	 Prepare Documents for Distribution
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Create Letters and Memos | Microsoft Word Chapter 1  •  139

Review

Skills 
Number Task Step Icon Keyboard Shortcut

1 Display formatting marks Home tab → Paragraph group → Show/Hide Ctrl  + *

2 Apply styles Home tab → Styles group → click desired style

2 Ignore flagged words Right‐click the word, and click Ignore All

2 Change spelling and grammar options File tab → Word Options → Proofing page → Settings button

3 Select paragraphs Triple‐click the paragraph, or with the  pointer, double‐click

3 Undo an action Quick Access Toolbar → Undo (repeat as needed) Ctrl  + Z

3 Select all Home tab → Editing group → Select → Select All Ctrl  + A

3 Move to beginning of document Ctrl  + Home

4 Move to end of document Ctrl  + End

4 Copy text Select text, then Home tab → Clipboard group → Copy Ctrl  + C

4 Cut text Select text, the Home tab → Clipboard group → Cut Ctrl  + X

4 Paste text Position insertion point, then Home tab → Clipboard group → Paste Ctrl  + V

5 Check spelling and grammar Review tab → Proofing group → Spelling & Grammar F7

6 Check writing style On Proofing page, set Writing Style to Spelling & Grammar

7 Use Format Painter Select formatted text, then Home → Clipboard group → Format Painter
Click once for one time, double‐click for multiple times

8 Open the Font dialog box Home tab → Font group → Dialog Box Launcher Ctrl  + D

8 Apply small caps In Font dialog box, select Small caps check box

8 Expand or stretch text Font dialog box → Advanced tab

9 Make footers active Insert tab → Header & Footer group → Footer → Edit Footer

9 Insert file names in footers With footer active → Design tab → Insert group → Quick Parts

10 View two pages View tab → Zoom group → Multiple Pages

10 Save as PDF documents File tab → Export → Create PDF/XPS

The following table summarizes the Skills and Procedures covered in this chapter.
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Review

A	 Cut
B	 Field
C	 Formatting mark
D	 Header
E	 Manual page break
F	 PDF document
G	 Point
H	 Spelling
I	 Style
J	 Thesaurus

Matching
Match each term in the second column with its correct definition in the 
first column by writing the letter of the term on the blank line in front of 
the correct definition.

___	 1.	 A character that indicates a paragraph, tab, or space on your 
screen, but that does not print when you print a Word document.

___	 2.	 A pre-built collection of formatting settings that can be assigned 
to text.

___	 3.	 A red wavy line indicates this type of error.

___	 4.	 Forces a page to end, and places subsequent text at the top of the 
next page.

___	 5.	 A command that deletes the selected text or object and places a 
copy in the Office Clipboard.

___	 6.	 A reference that lists words that have the same or similar 
meaning to the word you are looking up.

___	 7.	 A unit of measurement for font sizes.

___	 8.	 A reserved area for text, graphics, and fields that displays at the 
top of each page in a document.

___	 9.	 A category of data—such as a file name, the page number, or the 
current date—that can be inserted into a document.

___	 10.	 An image of a document that can be viewed using a reader such 
as Adobe Acrobat Reader instead of the application that created 
the original document.

	 1.	 What is a professional network and how would you 
build one?

	 2.	 �What are some of the best sources for job leads?
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Figure 2

Figure 1

	 1.	 Start Word 2013, and then open the student data file that came with this 
project, wrd_CPVisitUs. Use the Save As dialog box to save the file to your 
drive with the name Last_First_wrd_CPVisitUs Insert the FileName field in 
the footer.

	 2.	 Use Find and Replace to replace all occurrences of City of Aspen Falls with 
Aspen Falls

	 3.	 Change the document’s theme to Ion Boardroom, and then in the first line of the 
letterhead, change the font size to 18, apply the Small caps effect, and then set 
the character spacing to Expanded by 2 pt.

	 4.	 In the letter greeting, change the word Mrs. to Ms.
	 5.	 In the first letter body paragraph, insert a footnote after the word interns. For 

the footnote, type the following: This intern is majoring in recreation and did 
this analysis as a class project.

	 6.	 Near the bottom of Page 1, after the text City Hall, insert a manual page break, 
and then compare your screen with Figure 1.

	 7.	 At the top of Page 2, delete the blank paragraph, and then select the text 
ASPEN FALLS. Change the Font to Verdana, the size to 42 and then apply the 
Gradient Fill ‐ Orange, Accent 4, Outline ‐ Accent 4 text effect.

	 8.	 For the text Get out and join the party!, apply Bold and Italic.
	 9.	 For the newsletter articles, starting with Get Out! and ending with Borax Trail 

era, apply two columns of equal width with 0.3 spacing between them.
	10.	 For the article title, Get Out!, apply the Small caps effect, and then change 

the font color to the fifth theme color—Plum, Accent 1. Center align the 
paragraph, change the Spacing Before to 12 pt, and then compare your screen 
with Figure 2.

Continue to the next page to complete the skill

C a p s t o n e  p r o j e c t

Student data files needed for this project:

You will save your file as:

wrd_CPVisitUs
wrd_CPFestival

Last_First_wrd_CPVisitUs
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I n t e g r a t e d  p r o j e c t 1
Format Academic Reports and Include 
Information from the Web

Aspen Falls City Hall
In this Integrated Project, you will write an academic report for Donald 
Norris, Aspen Falls City Engineer. The report provides a brief overview 
of the benefits and costs of rooftop gardens—gardens placed on top 
of buildings in the city.

If someone has requested that you write a report for them, you 
should ask them for guidelines regarding length, style, and format. 
Many college instructors prefer the MLA style because of its simplicity, 
readability, and flexibility. If you are writing an academic research 
paper, your instructor or college will likely have specified which style 
and edition of that particular style you should follow. They will also 
likely provide the resources you need to research, organize, write, and 
format the paper.

In this project, you will format a research paper following the MLA 
style manual, seventh edition. You will research a topic on the Web, 
paraphrase the information, and then cite the source. Finally, you will 
add a Works Cited section to the report.

▶	 When writing a research paper, you will often be required to use the 
style guidelines provided or designated by your school or instructor.

▶	 Many colleges require that research papers follow guidelines based 
on those for academic books and journals. Commonly used style 
guidelines for research papers include the MLA (Modern Language 
Association) and the APA (American Psychological Association) style 
manuals.

▶	 When copying content from web pages, you need to follow certain 
guidelines to avoid copyright infringement.

▶	 When paraphrasing information written by someone else, you need to 
add a reference to show the source of the information.

▶	 When citing the source of content copied from a web page, you can 
copy the website’s address and paste it into your citation.

© alisonhancock / Fotolia 
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Aspen Falls City Hall
This project assumes that you are working at a computer that does 
not have the desktop version of Microsoft Word installed. Instead, 
you will create, edit, and format a flyer using Word Web App. You will 
create a document for Leah Kim, Parks and Recreation Supervisor. The 
flyer needs to outline the city’s policy for photography in city parks.

The Word Web App is used to create or open Word documents 
from any computer or device connected to the Internet. When 
needed, you can edit text, format the document, or insert objects 
such as pictures and tables. You can save these documents on your 
SkyDrive and continue working with them later when you are at a 
computer that has Word 2013 available. In Word Web App, you edit 
your document in Editing View and view the document as it will print 
in Reading View.

In this project, you will use Word Web App to create a short flyer. 
You will type and edit text, apply styles, and create a bulleted list. You 
will insert a picture from a file, size and position it, and then insert 
a table. Finally, you will open the document in Word 2013 to format 
the table.

▶	 Word Web App is a cloud‐based application used to complete basic 
document editing and formatting tasks using a web browser.

▶	 Word Web App can be used to create or edit documents using a web 
browser instead of the Word program—Word 2013 does not need to 
be installed on your computer.

▶	 When you create a document using Word Web App, it is saved on 
your SkyDrive so that you can work with it from any computer 
connected to the Internet.

▶	 You can share your document with colleagues or groups, either giving 
them read‐only access or allowing them to edit the document.

▶	 You can use Word Web App to perform basic editing and formatting 
tasks including inserting tables and images.

▶	 If you need a feature not available in Word Web App, you can edit 
your document in Microsoft Word and save it on your SkyDrive.

Create Flyers Using Word Web App

W e b  A p p  P r o j e c t

© Maridav / Fotolia 

9780133142686_WRD_WAP.indd   264 18/02/13   3:20 PM

USKAAAN
Callout
Web App projects 


	Skills for Success Marked Up Changes.pdf
	9780133142686_WRD_INT
	9780133142686_WRD_C01.pdf

	9780133142686_WRD_CAPS
	9780133142686_WRD_IP01
	9780133142686_WRD_WAP



